
 

 

Why use Clicker 4? 

 It can provide beginning readers and writers support in writing through the use of word 

lists by using whole words and words in the context of sentences. 

 A well organised grid can structure a learning task. 

 It can make the pupils more independent as there is no need to rely on anyone else for 

support. 

 High quality images can be used in the grids, thus enhancing the relevance and quality 

of materials used in the classroom. 

 Grids can enable the children to participate in learning activities that they would 

otherwise not be able to do. 

 The on-screen grid can be an alternative keyboard for a learner with a coordination 

difficulty. 

 Grids can be scanned and used by switch users. 

 Talking Story Books (fact or fiction) can be made that are relevant and age 

appropriate. 

 Grids can be used to support a wide range of curricular areas.  

 Grids can be used for fun activities such as quizzes to consolidate learning. 

 Cells can contain sounds or can be set to speak. 

 Grids can be colour coded to provide additional support for a task. 

 

 

Practical points for grid creation 

 

 Become familiar with the software to create the grids. Find out the limits of the 

program. Will it actually do what you want it to do? This will avoid disappointment and 

time wastage. 

 Look at the example files that go with the program (and ones you have downloaded) to 

get ideas.  

 If you wish, use a blank paper grid to plan your grid.  

 Print out some of the template grids and photocopy them to use for planning. 

 Prepare a test grid that is simple so that you can get to grips with the program.  

 Use the tutorial to learn about and practice some of the techniques.  
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 There is a wealth of clip art available so you do not need to be an artist. SEMERC and 

Sherston both do excellent collections of clip art relating to the curriculum and several 

reading schemes. You can also download clip art and pictures from the internet. 

 If you use PCS symbols (Boardmaker) purchase the CD of PCS symbols from Cricksoft 

to use in your Clicker grids. 

 Learn how to 'Manage the library' so that you can specify which pictures / graphics you 

want Clicker to use. 

 Consider the design of your grid carefully. Do not overload it with information. White 

space is important. Print size and font are important. 

 Be aware that learners can become involved in the designing of the grids. 

 Think of sensible names for your grid as you may need to be able to retrieve them at a 

later date for use with other pupils. 

 Be consistent. If you use areas for delete, enter, print or another common function on 

more than one grid, keep it the same size, in the same place and use the same word or 

icon. 

 If you are colour coding the grids be aware that if, for example, you are using a 

particular colour to indicate a word is a verb then the same colour should be used in any 

other grids. 

 If you have access to the internet there are Clicker grids available to download - 

www.clickergrids.com - use as they are or as a basis for your own. If you prefer, these 

are also available on CD's from Crick. 

 

 

Getting Started 

 

If you are completely new to Clicker then one of the best ways of seeing the wide range of 

what it can do is to try it some of the examples before you start making your own grids.  

 

Loading the program (PC) 

To start Clicker4, double click on the icon on the desktop or go through the Start menu 

and then All Programs and look for the  

 

Clicker 4 folder  then the Clicker 4 program  

 

 

 

Loading the program (Mac) 

To start Clicker4, double click on the icon on the desktop or go to the hard disk and look  

 

for the Clicker 4 folder then the program.   
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Log on 

When you see the Clicker4 log on screen select none and then 

click OK. 

 

 

 

 

 

 

When you log on as „none‟ you will be taken to the Clicker4 Home 

Grid.  

 

 

 

Clicker can be customised for different users, e.g. different font size or speech settings. 

You can set up a user name for each person and change the preferences while logged on as 

that person. When that person logs on their individual settings are loaded. Different users 

have their own Home grids so that they only have access to what is appropriate for them.   

 

Using a grid 

 

When in Clicker a single click will open a folder, file or grid.   

 

Click on See the Examples go to Sentence Building then Simple Sentences and finally 

Sentence1.   

 

ClickerWriter  

 

The top half of the screen shows  

ClickerWriter, which is the writing area;  

 

the bottom half displays the grid.  

 

 

 

 

Right click (PC), Ctrl click (Mac) to listen to the words; 

Left click (PC), Click (Mac) to put them into the writing area.  

 

The default word processor is ClickerWriter but you can choose another one using the 

Grid menu. Select Grid Properties, Send to tab, click in button beside Send to other 

application then Browse to locate your chosen word processor. 
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Entering & editing text in a cell 

Shift left click (PC), Shift click (Mac) to enter/edit text.  Edit the top line of cells to 

make a new sentence.  Now click on the cells to enter the sentence into the word 

processor. 

 

 

Grid appearance  

Cell colours, grid colours, fonts and font colours can all be 

changed. 

 

Shift right click (PC), command click (Mac) on a cell to get 

the Cell properties window. 

 

You can type in new text or choose a different graphic in the cell properties window.  It is 

also possible to take the borders off the cells or make them transparent - the background 

colour (or graphic if you used one) will show through. Experiment with changing the 

colours, fonts etc 

 

Printing grids and documents 

Go to the File menu and down to Print Grid.   You may wish to select Landscape rather than 

Portrait, depending on the grid.  If you select Print Document then the writing area is 

printed out. 

 

Keyboard 

You can use the keyboard to type as well as using the text in the cells. You may wish to use 

a grid to offer an extended vocabulary to support writing but have the user key in the 

rest of the text from a keyboard.   

 

Clicker Writer is set to speak the sentence when punctuation is added at the end of a 

sentence. This is very good to reinforce the importance of ending a sentence with a full 

stop.  Make sure you add one to your grid if the user is not accessing the standard 

keyboard.  

 

Tutorial 

Clicker 4 has a tutorial which is accessed by going to the Help menu and selecting Clicker 

Tutorial ...  

 

This takes you through a range of skills and techniques and is worth a look. 

 

For more help press F1 and this takes you to the Clicker Help topics.  
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Making a Clicker 4 grid  

 

Load Clicker 4 (PC - Start > Programs > Clicker 4; Mac - in Clicker 4 folder on hard disk). 

 

Log on dialogue box appears - click on (none) – the name you are 

logging on as for this exercise. 

Click Okay. 

 

 

The Home Grid opens 

 

Click on Make a Clicker Grid 

 

 

 

 

Templates 

The templates window will open giving you a selection of different types and sizes of 

template to choose from. For this task click on the Word Grids Tab and select Words4 

then OK. 

 

 

(PC)  (Mac) 

 

 

 

 

 

The word grids are set to send to Clicker Writer. 

 

 

 

 

A blank grid opens along with Clicker Writer, Clicker‟s own 

word processor. 

 

 

 

 

You are now ready to create a grid using the blank grid. 
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To enter text into the cells 

 

Move the pointer to the first cell. Hold down the shift key and click (PC - shift left click, 

Mac - shift click). You can now type in the text for that cell. 

 

Press the tab key to move to the next cell. Type in the text for that cell. 

 

Continue until you have completed the cells (or those that you wish to fill in) then press 

Return. 

 

The cells should speak the text contained in them when the right hand mouse button is 

pressed (PC) or control click is used (Mac) 

 

 

 

 

 

 

 

 

 

To save your grid 

It is good practice to save your grid from the very early stages of setting it up.  

 

Click on File 

Select Save Grid As... 

 

 

 

 

 

In the save grid dialogue box locate where you want the 

file to be saved and give your grid an appropriate name. 

 

 

 

 

Carry on filling in the grid - keep saving it regularly by selecting Save Grid and, because 

you have already given the file a name, the file will be updated. 
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How to capitalise the next letter following a full stop in a Clicker 4 grid 

 

 Make your Clicker grid and put a full stop in the required cell. 

 

 With your pointer on the full stop cell, hold shift and right click (PC) or hold down 

command (the one with the apple on it) and click the mouse button (Mac). 

 

 You will see the Cell Properties window : 

 

 

 

 

 

 

 

 

 

 

 

 

 Click on the Send tab and the following window appears : 

 

 Near the bottom left of the screen 

you will see a wee square beside the 

words “Capitalize next letter”. 

 

 Click in the square – it should 

now be ticked. 

 

 Click on OK. 

 

 

 

 

 

 

 Now, when you finish a sentence using the full stop in the grid, the first letter of the 

next sentence will automatically be capitalised. 
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To Link Grids 

When you are creating grids to be linked it is important to leave a cell available to link one 

grid to another.  

 

Plan your set of grids carefully.  

 Is the link cell always going to be in the same place on each grid? 

 Are any other cells going to be common to all the grids? 

 Think about setting up a template grid which can be easily edited. 

 Are you going to colour code the grids or cells? 

 Is it appropriate to look at the grids being produced in other classes - should they be 

standardised? If you have all verbs in green but the next class has prepared verbs in 

yellow the value of the colour coding may be lost. 

 

Prepare the set of grids first 

When you are making sets of grids it is important to keep them together in one folder. 

  

Create a new folder 

From the Clicker 4 Home Grid click on the Clicker Explorer icon.   

 

On the Clicker Explorer toolbar click on 

the New Folder icon 

 

 

A folder will be added to the list called 'New Folder'. The name is highlighted. Type in the 

name for your folder and press Return/Enter.As the folders are sorted alphabetically it 

will move to its correct position in the list. 

 

Click on the Home Grid icon and either click on Make a Clicker grid or go to the file menu 

and choose New Grid.  Choose the grid you want from the templates or make a new one. 

Put in the text, graphics and/or photos you want in the cells. (More on graphics later.) 

 

Remember to save your grid regularly (File > Save Grid As…) then use Save Grid to 

update the grid. 

 

Naming grids 

If you are creating a set of grids to be followed in order (e.g. for a storybook) save the 

grids using consecutive numbers such as my story1, my story2, my story3 etc with no space 

between name and number.   

 

The forward and back buttons will then automatically load the 

next or previous numbered grid.  

 

If the grids are not dependant on a sequence then you need to make the link yourself. 
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To make a link  

Open the Cell Properties dialogue (PC – shift, right click on the cell, Mac - command click).   

 

Click on the Open grid tab then Open this Grid button.   

 

Click on Browse, locate the grid to be opened and double 

click on it or type in the name of the grid, then 

 

Click OK 

 

 

 

Deleting, Adding, Moving and Resizing Cells 

 

Deleting cells 

Select the cell(s) to be deleted (PC - Ctrl left click, Mac – Ctrl Command click) 

Go to the Grid menu, down to Delete and across to Delete cell. All cells that have been 

selected will be deleted. 

 

Adding a cell 

Go to the Grid menu, down to Insert and across to Insert Cell 

A new cell will appear 'stuck' to the mouse pointer. Click in the grid to place the cell. It 

can be moved if it is not in the right place. 

 

Moving a cell 

Hold down the Alt key and when the mouse pointer is inside a cell the pointer will show as 

crossed arrows. The cell can now be dragged into the required position. 

 

Resizing a cell 

Hold down the Alt key and move the mouse pointer to the bottom right of the cell and it 

will change to a two headed arrow. The cell can now be resized by dragging on the corner 

when the two-headed arrow is there. 

 

User Preferences 

 

When you are logged on as a particular user 

various preferences can be set for that user.  

 

Go to Options menu (PC) [Edit menu (Mac)] and 

select User Preferences. 

 

 

 



Page 10 of 11 

Instant Pictures.  

Use this to set  

 whether or not you want the pictures to appear in the writing window 

 whether or not you want pictures in the cells 

 which pictures (graphic libraries) you want to use (or if you want to manage the 

libraries). 

 

Speech  

This enables you to set when speech is heard, to choose the voice, and set the speed and 

pitch for Clicker Writer and the Grid. Try these out as they can make a difference. 

 

Toolbars  

This is where you can customise the look of the Writer, Grid and Explorer toolbars.   

 Large tools and Small tools lets you change the size of the tools on the Writer, 

Grid and Explorer toolbars.  

 No tools removes all tools from the Writer, Grid or Explorer toolbars. 

 To add or remove individual tools from the Writer or Grid toolbars, click on the 

tool you wish to add or remove. When the tools are indented they will appear on the 

toolbar.  

 Check „Include Text‟ to place the tool name beneath the tool on the Grid toolbar. 

 

Spellchecker  

This tab allows you to set up how you want the spellchecker to appear and which list of 

words to use – go to F1 Help topics and type Spellchecker in the index for full information 

on this feature. 

 

Included in the Spellchecker tab is Pictures. Choose here whether to have pictures in the 

Grid only, in both the Grid and Writer, or none at all. 

 

Pointers (Cursors on Mac) 

This allows you to choose a different pointer for the grid.  Pointers can also be set for 

individual cells – e.g. use the Happy face pointer when the pointer is on the cell which is 

the correct one to use at that time. 

 

Other allows for a range of different options to be set. 

 Default font enables you to select a font and size which becomes the default font 

used in all new Clicker Writer documents and new Clicker grids. 

 

 Editing and saving options let you  

o Trap mouse: this option [not available in Mac version] is provided to prevent 

the user from making any unwanted actions outside the Clicker 4 grid. The 

mouse pointer is trapped inside the grid. To untrap the mouse, Shift-Right 
Click on the Clicker Grid. 
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o Disable easy editing prevents any grid editing with the keyboard shortcuts. 

o Disable saving of grids prevents any grids being saved to disk. 

o Automatically save grids automatically saves the grid on exit. 

 

 Miscellaneous 

o Use simple Save dialog when saving documents. This option is mainly for 

Switch users enabling them to save their own Clicker Writer documents. All 

that opens when the user chooses Save Document As... in the File menu is a 

box enabling them to type in a name. The document is saved to the current 

folder. 

o When adding a cell graphic, change action to 'Send graphic'. Check this 

option to force Clicker 4 to automatically set Cell Properties: Send to 'Send 

graphic & text', so when adding a graphic, it will always be sent to the word 

processor. 

o Automatically go back to previous grid after using Wordlist grid. This 

sets Clicker 4 to always take you to the previously used grid immediately 

after a cell has been clicked on in a Wordlist grid. 

o Use simple Wordlists.  With this option checked, Clicker uses the simple 

wordlist set designed for younger users when the Wordlist icon is clicked on 

the Grid toolbar. 

 

 


